
 1) Which of the following picture is suitable to be included in a)
 Poster created in Inkscape software without loosing its clarity?

a) image.jpg

b) image.svg

c) image.png

d) image.bmp

2) Which of the following option will be used to arrange 
one of the two objects drawn in Inkscape above the other?

a)  Raise

b) Below

c) Up 

d) Down 

3) Which one of the following  technique is used to  change
the depth of the colour given to an object?

a) Flat color

b) Opacity

c) Path

d) Offset

4) Select the activity that can be done using the  tab Stroke paint  in Fill and Stroke window.

a) To give colour to the object

b) To remove the colour of the object.

c)  To give colour to the outline of the object.

d) To change the style of the object.

5)Which one of the following is a Vector Image file?

➢ Circle.png

➢ Circle.jpg

➢ Circle.svg

➢ Circle.gif

 6 Anu included a picture image.png  to the poster drawn in Inkscape

CHAPTETR 01

http://www.shenischool.in/
https://t.me/Shenibloggroup


 and enlarged it.Which of the following statements is true about it?

➢ The clarity is not changed as enlarged

➢ The clarity reduces as enlarged

➢ The clarity increases as  enlarged

➢ All the above three statements are wrong.

7) Name the technique suitable  to combine  more than one picture as a single unit.

➢ Clip 

➢ Mask

➢ Transform

➢ Group

8) Choose the suitable option to export a picture in Inkscape with the same size of the canvas.

➢ Page 

➢ Drawing

➢ Selection

9) Which of the option can be used to align the  text with the semicircle  drawn in Inkscape?

➢ Text → Text and Font. 

➢ Text → Put on Path 

➢ Text → Remove from Path

➢ Text → Convert to Text.

10) Identify the tool  in the Tool box of Inkscape software.

➢ To draw a square

➢ To draw a circle

➢ To edit the node

➢ To include text

11) Which of  the following technique can be used to give 
light and shade effect to the circle drawn in Inkscape  software?

➢ Blur

➢ Fill
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➢ Opacity

➢ Gradient

 

12) The three different stages to draw the image of a tea cup in 
 Inkscape is given above .What will be the activity done
 in the second figure to get the third one?

➢ Object ⟶ Group

➢ Fill and Stroke ⟶ Opacity

➢ Path ⟶ Difference

➢ Edit ⟶Duplicate

           

            1                     2

13)  Two different pictures drawn in Inkscape is given.
Which among the following technique can be used to modify the first picture to obtain the second 
picture 

➢ Object  ⟶ Group

➢ Fill and Stroke⟶Blur

➢ Path ⟶Difference

➢ Edit ⟶Duplicate

14) Choose the true statement about Picture files from the following

➢ svg pictures are Vector Images.

➢ Clarity loses on scaling the vector images.

➢ Bitmap pictures are also known as Vector images.

➢ svg pictures are Raster images.. 

15) Which is the key used along with mouse click to give  colour 
to the stroke of an object  from the colour palatte of Inkscape?

➢ Shift
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➢ Space

➢ Tab

➢ F1

16)Give the expanded  form of  SVG 

➢ Stable Vector Graphics

➢ Scalable Virtual Graphics

➢ Steady Vector Graphics

➢ Scalable Vector Graphics

17) Choose a Vector Image Editing Software from the following 

➢ GIMP

➢ Tux paint

➢ Xpaint

➢ Inkscape

18) The various steps to create an image of a tea  cup is 
shown in the picture .Draw an oval in the vertical direction 
and a circle on the top of it then  remove the circle on the 
top and make the oval to the shape of a cup.Which among 
the following technique will help to do this?

➢ Path → Difference

➢ Path → Union

➢ Path → Raise

➢ Path → Group

19) Choose the correct step to save a picture 
created in Inkscape in png format.

➢ File → Save As

➢ File → Export PNG Image

➢ File → Import Clip Art

➢ File → Save a Copy

20) Whichthe following is a Free Vector Image editing software?

➢ Libre Office Draw

➢ Adobe Illustrator
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➢ Corel Draw

➢ Gimp
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1) Which of the following technique is suitable to copy the text or the object of 

the given format to another in Libre Ofice writer?

➢ Mail merge

➢ Filter

➢ Index Formatting

➢ Clone Formatting

2)2) Write the feature in word processor used to

 define the words as Headings in a document. 

➢  Apply Style box

➢ Paragraph Formatting

➢ Apply Filter

➢ Page Formatting

3) Which among the following is the file   prepared in word Processor?

➢ Certificate.ods

➢ Certificate.odt

➢ Certificate.odp

➢ Certificate.odg

4) 4) Select a Word Processor Software   from the following.

➢ LibreOffice Impress

➢ Libre OfficeWriter

➢ LibreOfficeMath

➢ LibreOffice Draw

5)5)Which is the technique used to include an Index Table

 in a word processor document?

➢ Header

➢ Index

CHAPTER 02
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➢ Table

➢ Indexes and Tables

6) 6) Libre Office writer recognises the headings and the sub headings basedon 

certain features. Name the feature identified by a computer to make it as an 

Index Table.  

➢ The colour of the headings  and sub headings.        

➢  The  size of the headings  and sub headings     

➢  The  style of the headings and  sub headings

➢ The indent of the headings and  subheadings

7) 7) What should be done to go to the related pages from 

the headings of the Index table.

➢ Click on  the heading by  pressing the Ctrl key                                              

➢ Click on the heading by pressing the Alt  key                                     

➢   Click on the heading by Pressing the Shift key                                                 

➢  Click on  the heading by  pressing the Tab key 

8) 8) It is decided to include the name and addresses of the recepients  one by one  

from a table  to make separate letters  in Word Processor.Which one of the 

following technique is suitable to this?  

➢ Formatting

➢ Style

➢ Mail Merge

➢ Index

9)         9)         Identify the function of Mail merge facility  in word processor

➢ To add the data from a  database  to a document as required

➢ To add the data fro m a document to a database as required

➢ To convert a database created in Spreadsheet to another database.

➢ To select necessary data from  a database  to form  a 
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10)        The opinion of two students about the use of  the technique Mail merge  

is given below.               

1.  The  certificates can be prepared using 

                    the table of winners in the kalolsavam 

              2.   The participant card can be prepared 

                     using the table of participants.

Choose the correct statements from the following

➢  Both the  statements are wrong.

➢ First statement is true and  the second one is false. 

➢ First statement is false but  the second one is true.

➢ Both the statements are  true.

11) The following statements give the advantage of using Style in a 

document .Select the   statement that is NOT true.

➢ Once  the style has applied modifications  can be made later to those styles 

only. 

➢ The changes will be seen at all places where  the style has been used.

➢  It makes  easy to modify the  appearance of  text and headings 

 in preparing books or documents.

➢ Style can be used to include data  one by one from a database to a word 

file.

13) The fields from a database can be included to a document using the technique 

MailMerge.

 What should be done to get the mailmerged document. 

➢ Print the document

➢ Export the document

➢ Save the document

➢ Wrap the document

https://t.me/Shenibloggroup


13) Each column of a database used for mail merge is known as ........

➢ Field

➢ Frame

➢ Form

➢ Record

14) Identify this tool in   Libre Office Writer

➢ Print Tool

➢ Drawing Tool

➢  Clone Formatting Tool 

➢ Brush Tool

15)              Identify the Clone Formatting Tool from the following.

A.                 B              C.          D      

16) Which is the easiest method to change the format given to the headings of a 

document or a  book.

➢ Character Formatting

➢ Paragraph Formatting

➢ Apply Style Box

➢ Page Formatting

17) In which of the following software  the technique  Mail merge  is available?

➢ LibreOffice Impress

➢ Libre OfficeWriter
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➢ LibreOfficeMath

➢ Libre Office Draw

18) What is the step to be followed to go to the related page of content  from  an 

Index table 

after exporting it in to pdf format?

➢ Click at the link from the Index Table  

➢ Click at any line of the Index table and press Alt key

➢ Click at any line of the Index table  and press Ctrl key

➢ Click at any line of the Indextable  and press Shift key

19)        The different methods suggested by two students to make  changes in the 

Index Table is given below.

Which among the following is true?

Arun:  Click on the Heading in the Index Table ,

 select the style of the  heading  from the Styles and  formatting window and 

click Modify

Vimal: Click on the heading of the Index Table then click update Index and 

Table and make  the heading attractive 

➢ Both the suggestions are true.

➢ The suggestion of Arun is  right and that of Vimal is wrong.

➢  The suggestion of Arun is wrong  and that of Vimal is right.

➢ Both the suggestions are wrong.

20) What can be done to  modify the style  given to a document?

➢ Right click on the style and select Modify

➢ Click on the style and select Modify

➢ Select the heading and make   necessary changes.

➢  . Right click on the Style  and click Reset
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STANDARD X INFORMATION TECHNOLOGY    

UNIT 3: ATTRACTIVE WEB DESIGNING : THEORY QUESTIONS

BY: PRAPHUL P : EACHOME KANNUR 

1) What is the function of cascading style sheets while making a webpage?

a) Define the browsers for opening the web pages.

b) To include videos in webpage.

c) Define the copyrights of the webpage

d) directs how a webpage should be displayed in Mark-up Language.

2) Which of the following tags used to  include a style sheet file in a web page ? 

a)<css>  B)<link>c)<hyperlink>d)  <Interlink>

3) When Anu was preparing webpages, she created Cascading Style Sheet file to 

include fonts and colours.Which of the following may be that file?

a) home.html b) index.odt c) style.css d) image.png

4) Which of the following statements is used for adding background colour to 

the h2 tag headings of a web page using Cascading style sheet?

a) h2(background:green) b) h2{background:green;} c) 

h2<<background:green>>

d) h2[background:green]

5) While creating webpages, styles can be included along with the html tags 

using cascading style. what it is called?

a) Inline.CSS  b) External.CSS  c) Internal.CSS  d) style.CSS

6) Which of the following codes can be used in a css file for applying same font 

family to h2 headings of a web page using External cascading style?

a) h2-font-family=”DejaVu Sans”

b) h2-font-family=DejaVu Sans

c) h2{font-family:DejaVu Sans}

d) h2<font-family=DejaVu Sans>
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7)When creating Web sites, which of the following features can be used to 

define margins, fonts, colors?

a)  Index Table   b)  Cascading Style Sheets c) Mail Merge d)Formatting

7) Who put forward the idea of cascading style sheet to eliminate the repetition 

of code for  fonts, margins and colors used in web page creation ?

a) Hakon Wium Lie and Bert Bos  b) Richard Stallman, Linus Torvalds

c) Jimmy wales, Douglas englebart d) Steve Jobs, Mark Zuckerberg

8) When Preparing a web Page using cascading style , which of the following 

can be used to define font size? 

a) <p font =24> 

b)<p style=”font-size:24px;”)

c) p font size=24px

d) p font-size=24px

9) Which of the following  cascading styles  may be used to define the properties

of  heading in a web page?      

a)  <h2>[style=”color:#ff0000;”]          b)       <h2 style=color:#ff0000;”> 

….</h2>                                                           ….</h2>  

c) <h2> {style=”color:#ff0000;”}         d)       <h2( style=color:#ff0000;”> 

….</h2>

10) A cascading style sheet file was prepared and saved in a folder for the school's

Little Kites Unit to add to the web site prepared by Anusha. Find the style 

sheet file from the files in this folder.

littlekites.html                  littlekites.png

littlekites.css                       littlekites.odt

11) It was decided to give the color # 952CBA to the headings  in a webpage. Using 

cascading style sheet  Which of the following should be used?
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a       h2 {font-color=#952CBA}            b)        h2 {color=#952CBA}              

c) h2 {font-color:=#952CBA}    d) h2 {color:#952CBA;}

                     

12) It was decided to use the Cascading Styles on a web page to give the headings

a background color # CD9FDC. Which of the following can be used?

   a) h2{background=#CD9FDC;}            b)   h2{background:#CD9FDC;}    

        c) h2{background=#CD9FDC}            d)  h2{background:#CD9FDC}        

13) Which of the following can be used to give the letters in a paragraph the font 

family” Ubuntu condensed” using cascading style inline method in a 

webpage.

a) <p style:”font-family; Ubuntu Condensed”.....<p/>

b) <p style=”font-family: Ubuntu Condensed;”>.....<p/>

c) <p>”font-family:Ubuntu Condensed;”.....<p/>

d) <p> ”font-family=Ubuntu Condensed;”.....<p/>

Paragraphs  in a page should be colored # 332211 using the cascading 

style .which of the following  should be use for this purpose?

 a)       p{color=#332211                           b)       h2{color=#952CBA}                        

 c)  p{color;#332211;}       d)       p{color:#332211;}                             

14)  The source of the webpage prepared by Sonu is given   here. In this green, 

colour should be given to the  heading (h2). For this, pick out from below that 

 should be used in between <style>tag. 

a) h2{color>>green;} 

b) h2{color:green;} 

c) h2{color<<green;} 

d) h2{color==green;}
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15) Karthik decided to use the cascading styles to color the words in paragraphs 

while designing a webpage. Which of the following can be used for this?

a)p{font-color=#ff0000;}

b) p{font-color:#ff0000;} c) p{color=#ff0000;}

d) p{color:#ff0000;}

16) Cascading style sheet, style.css is to be included in a webpage designed by Anu. 

Which of the following can be used for this?

a) < head rel=”stylesheet”

type =”text/css” href=”mystyle.css”>

b)  < link rel=”stylesheet”

        type =”text/css” href=”mystyle.css”>

c) < body rel=”stylesheet”

type =”text/css” href=”mystyle.css”>

d)  < style rel=”stylesheet”

type =”text/css” href=”mystyle.css”>

17) While Designing a web page, Sudev decided to give font Style Verdana for 

words in the paragraphs. Which one of the following Cascading styles can be 

used for this?

a) p{ font-family=Verdana;}

b) p{ font-family:Verdana;}

c) p{ font:Verdana;}

d) p{ font=Verdana;}

18)  When we create webpage, Which icons should be included after the name of 

the tag to give the attributes

of a tag in Cascading Styles?

a) <>    b) []   c) {}    d) ()
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19) While designing a webpage, Himesh gave the background colour for headings

and text colour for paragraphs using External Cascading styles. Which one of 

the following attributes can be used for this.

a)  h3{bgcolor:#D990D2;}

p{color:#34289C;}

b) h3{background=#D990D2}

p{color:#34289C;}

c)    h3{bgcolor:#D990D2}

p{color=#34289C}

       d) h3{background:#D990D2;}

p{color:#34289C;}

20) Which of the following statements are true, while using cascading styles for 

web designing?

a) Use (.) to separate Attributes and Values.

b) Use (;) to separate Attributes and Values.

c) Use ({}) to separate Attributes and Values.

d) Use (:) to separate Attributes and Values.

21) While using cascading styles in web pages, which of the following attributes 

is used to define font name?

a) font    b) font-name     c) font-property    d) font-family

22)  Which one of the following is the symbol used for separating the style and 

value of a selector while preparing

Cascading style?

a)Colon(:)

b) Semi colon(;)

c) Full stop(.)

d) Bracket({})
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23) While using Internal Cascading style, which of the following codes can be 

used for applying background colour in a webpage?

a)<body style=”background: blue”>

b) body{background:blue}

c) body<<background:blue>>

d) <style> body{backgound: blue} </style>

24) Sabu is creating a web page. Which tag should be used to display a sentence 

in the next line?

a <br>   b. <cr>    c). <tr>  d) <pr>

25.

In the above given

web page codes, the

cascading styles are included as..........…

a) Inline CSS  b) External CSS  c) Internal CSS  d) Style CSS

26.  Which type of the following cascading styles is used to define the heading in the

given web page codes?
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A. Element Selector

B. Class Selector

C. Internal Selector

D. External Selector

27.  What is the full form of WCMS, used for creating websites?

a) Web Content maintenance System  b) Web Content Management System

c) Wiki Control Machine Systemd) Wiki Content Machine System  d) Wiki Content Machine 

System

28) Style shields used in web pages are aslo  known by another name. What is that name?

a) Templates  b)  Editors c)  Composers d)  Mark ups
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1) Which of the following is the very first instruction of a Python Graphics program?

 Clear()

 begin_fill()

 from turtle import*

 forward()

2) What does the instruction  right(60) in a Python Graphics program indicate?

 To make the turtle turn 600  right.

 To draw a line with 60 unit length.

 To draw a circle with 60 unit radius. 

 To mark a point at a distance of 60 unit.

3) Identify the additional software required for the creation of geometrical figures in 

Python Programming Language. 

 turtle

 import

 python shell

 IDLE 

4) Which of the following windows displays the output of a Python Graphics program?

 Python Shell

 IDLE window 

 Python Graphics Window

 Web Browser

5) The given Python program is to create an Equilateral Triangle. Which of the 

following instructions is to be included in the program to decide  the thickness of 

sides?  

 pencolor(5)

 pensize(5)

 pen_thickness(5)

 penline(5)

6) Which of the following instructions is to be used in a Python Graphics 

program to give different colours to the geometrical figures?

 pen-color()

 pencolour()

 colour()

7) Identify the output of the given Python Graphics program.

STANDARD X ICT – CHAPTER 4: PYTHON GRAPHICS- QNS - ANS
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 Square 

 Rectangle

 Regular Pentagon

 Regular Hexagon

8) Observe the given Python Graphics program.    Which of the following

values is to be given in the instruction right(__) to get a Regular Hexagon.  

 60

 72

 90

 120

9) Identify the output of the given Python Graphics program.

 Square 

 Rectangle

 Regular Pentagon

 Regular Hexagon

10) Identify the output of the given Python Graphics program.

 Square 

 Rectangle

 Regular Pentagon

 Regular Hexagon

11 ) Identify the instruction to be given in the Python Graphics program to mark a red dot

in the  Graphics window as given in the picture.
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 dot(20,"red")

 dot("red",20)

 point(20,"red")

 point("red",20)

12) The output of the given Python Graphics program is a Square. Identify the 

Instruction to be given in the program to colour the sides 

of the Square with green.

 clr("green")

 linecolor("green")

 pencolour(green)

 pencolor("green")

13) Identify the command used to make the Python instructions execute repeatedly in a 

program. 

 for

 turtle

 forward

 iterate

14) The output of the given Python Graphics program is a Regular Hexagon.  

Identify from the following the peculiarity of the output Regular Hexagon.  

 Length of the sides is  60 unit. 

 Length of the sides is  100 unit. 

 The measurement of angles is 100 unit 

 Length of the sides is 6 unit.

15) How many circles should be there in the output of 

the given Python Graphics program?

 40

 101   

 20  

 4

16) When Anu run the given Python Graphics program, she got a message as "Invalid 

Syntax”. Which of the following instructions is to be used to solve the error?

 from turtle import*

 for i in range(3):

 forward(80)

 right(120)
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17) Identify the Python Graphics program segment which is syntactically correct and 

give correct output..  

 

  

18)  Identify the instruction to be included in the blank space of the given Python 

Graphics program to colour the outline of the geometrical figure with Blue and fill it 

with Yellow.

 pencolor(“blue”,”yellow”)

 pencolor(“yellow”,”blue”)

 color(“blue”,”yellow”)

 color(“yellow”,”blue”)

19) The given Python Graphics program contains two 'for' instructions. 

Name this type of Python programs with a 'for' instruction within another ' for' 

instruction.

 Loop

 Loop Statement

 Statement

 Nested Loop

20) When Anu run the given Python Graphics program, she got a message as 

"expected an indented block”.  Which of the following programs solve this error?

A B

C
D
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A B

C D

https://t.me/Shenibloggroup


STANDARD X  - CHAPTER 5: NETWORKING

THEORY QUESTIONS AND ANSWERS

1) Identify the number of wires found in a UTP cable used to connect computers in a network.

➢ 7

➢ 15

➢ 8

➢ 3

2) Identify the number of pairs of wires found in a UTP cable used to connect computers in a
network.

➢ 4

➢ 12

➢ 8

➢ 10

3) Identify the connector used to connect  the UTP cable to computer. 

➢ Serial Connector

➢ RJ 45 

➢ RJ 11

➢ Parallel Connector.

4) Which of the following is to be done to get the X-Ray photo of a patient in the 
computer 

of the Doctor directly from the X-Ray room? 

➢ Network the computers of X-ray room and Doctor's room.

➢ Connect Internet  to  Doctor's computer.

➢ Connect printer to Doctor's computer.

➢ Connect modem to Doctor's computer.
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5) Identify the connector which is used to connect Modem to Telephone Network. 

➢ Switch

➢ RJ 45 

➢ RJ 11

➢ Hub

6) Identify the device to which all the computers in a Network are directly connected 
with cables.

➢ Wi-Fi

➢ Bluetooth

➢ Hub / Switch

➢ Modem

7) Which of the following devices is necessary in a Computer Network to get the files 
in a computer in other computers. 

➢ Printer

➢ Scanner

➢ Hub / Switch

➢ Web Camera 

8)  Which of the following is used in Wireless Networks?

➢ Radio Waves

➢ Sound waves

➢ Infra Red Waves 

➢ Ultra Violet Waves

9 Identify the device used to convert the Digital signals to Analogue signals and vice 
versa.

➢ Modem
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➢ RJ 45 

➢ RJ 11

➢ Hub

10) Which of the following devices is essential to avail Internet 
through Telephone network?

➢ Modem

➢ Wireless Set

➢ Scanner

➢ Hub / Switch

11) Identify the set of numbers which can be an IP Address.

➢ 50.17.254.23

➢ 1935.1682.1785.1542

➢ 253-156-147-15

➢ 12.0-18.126

12) Which of the following is the name of Norms that are to be obeyed in naming of 
computers included in a Network? 

➢ IP Address

➢ Netmask

➢ Network Protocols

➢ Sharing

13) What is the maximum size of an IP Address as per IPv6 protocol? 

➢ 32 Bit

➢ 64 Bit

➢ 128 Bit 

➢ 16 Bit

14) Identify the type of Computer Network of Railway,Army, Banks etc.which are spread 
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through out the country.

➢ LAN

➢ WAN

➢ PAN

➢ MAN

15)  Identify the Protocol used to set the IP Address for computers in a Networked 
School lab. 

➢ TCP/IP

➢ POP

➢ SMB

➢ SSH

16) Which of the following can be the IP Address of a computer in a Network as per 

IPv4 protocol?

➢ 216.58.197.73

➢ 1935.1682.1785.1542

➢ 253-156-147-15

➢ 12.0-18.126

17) Which of the following can be an IP Address  as per IPv4 protocol?

➢ 192.168.200.258

➢ 192.258.192.192

➢ 192.168.256.10

➢ 192.168.222.10

18) Identify  Network Protocols from the following.

➢ SSH, SMB

➢ DNS, UTP

➢ CAT7, CAT8
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➢ RJ11, RJ45

19) Which of the following devices is essential to avail Internet facility in a computer?

➢ Cable

➢ Connector

➢ Switch

➢ Modem

20) Identify the server address used to connect a computer in a Network to another 
computer with the IP Address 192.168.1.15  in the same Network.

➢ dns://192.168.1.15 

➢ ssh://192.168.1.15 

➢ dhcp://192.168.1.15

➢ vlc://192.168.1.15 
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THEORY NOTES BY PRAPHUL P; EACHUR, KANNUR 

1. Identify the expanded form of IETF from the following.

➢ Internet Environment Task Force

➢ Internet Engineering Task Force   

➢ Internet Enterprises Task Force

➢ Internet Equipments Task Force

2.  Which system interchanges web  addresses (host names) to the 

IP address to help the computers( and vice versa)  ?

➢ VPN 

➢ DNS 

➢ Pv4

➢ IPv6

3. Who is the founder of World Wide Web?

➢ Linus Torvalds

➢ Richard Mathew Stallman.

➢ Tim Berners-Lee

➢ Donald knuth

4. IP addresses of the websites  are often translated to names that we

can easily remember (and vice versa). What are these names 

called?

➢ Domain name

➢ Hyper name

➢  Web name

➢  Resource name

5. Which of the following is a technique used to make online 

transactions more secure?

➢ IP

SSLC ICT – UNIT 7 The Working of the Internet 
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➢ WWW

➢ URL

➢ OTP

6. Which one from the following is an application protocol for 

transferring resources on the Internet?

➢ SMTP

➢ HTTP

➢ HTML

➢ SSH

7. In which name are the programmes for searching data from 

internet known as?

➢ Search Engines

➢ Search Icons

➢ Search Indexes

➢ Search Tools

8. Who foretold that the Internet would become omnipresent in our l

ives, so much so that it would effectively vanish into the 

background?

➢ Eric Schmidt

➢ Richard Stallman

➢ Ken Thompson

➢ Dennis Ritchie

9.What do we call the computers in which store the databases, 

information to share in   internet, applications for E-services 

etc.  ?

➢ Servers

➢ Protocols

➢ DNS
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➢ Diasporas 

10. Which is the false statement about the OTP we  get while making

online bank transactions?

➢ The password can be used for all transactions.                          

➢ Will get different passwords for each transaction. 

➢ Don't share it to anyone. 

➢ OTP will be sent to the mobile number which registered in bank.

11. Each content in a website has its own web address. Which one 

below is called so?

➢ URL

➢ DNC

➢  Protocol

➢ WWW

12. Which file in internet refers the URL of

http://www.plainenglish.co.uk/files/email.swf ?

➢ www web file

➢ swf email file

➢ email.swf file

➢ www.plainenglish.co.uk  file

13. What is known for deceiving by temptation or threatening `

through social media?

➢ Bullying

➢ Hoaxing

➢ Spaming

➢ Hosting

13. What is the full form of OTP which uses to protect the E-banking

services ?

➢ Online Testing Password
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➢ Online Transfer Password

➢ Open Technology for Password

➢ One Time Password

14. Which media is normally used to inform the customer about OTP

that uses to protect  E- banking services?

➢ Social Media

➢ Website

➢ Mobile phone

➢ Blog

15. Which command line uses in terminal to find the IP address of 

www.google.co.in ?

➢ ip google.co.in

➢ host google.co.in

➢ terminal google.co.in

➢ server google.co.in

16. Which is an online service site in given below that can't be 

called as a social media?

➢ Twitter

➢  Diaspora

➢ Wiktionary

➢ Whatsapp

17.Which is the protocol used to transact HTML files through internet  ?

➢ Media Transmission Protocol

➢ Hyper Text Transfer Protocol

➢ Media Transfer Protocol

➢ DNS Protocol

18. Which is the protocol in given below used by world wide web 

(www) ?  
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➢ SMTP

➢ HTTP

➢ POP

➢ SSH

19. Which among the below statements about World Wide Web is 

true ?

➢ Internet is the product of www.

➢ Tim Berners Lee is the father of www

➢ www is working according to DHCP  protocol

➢ ICANN controls www.

20. Which is the file transfer protocol used in the URL 

http://www.plainenglish.co.uk/files/email.swf?           

➢ ssh

➢ http

➢ files

➢ email.swf

21. Which is the website of an online dictionary?

➢ https://www.twiter.com

➢ https://www.en.wiktionary.com

➢ https://www.mozilla.org

➢ https://en.wiktionary.org

22. Which website helps us to share our own videos in internet?  

➢ youtube.com

➢ wikimapia.org

➢ kalamandalam.org

➢ wikipedia.org

23. Which society initiates the structure, attitudes and common 

discussions of internet?
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➢ World Wide Web 

➢ The Internet Engineering Task Force

➢ The Internet Corporation for Assigned Names and Numbers

➢ The Internet Society

SHORT ANSWER TYPE QUESTIONS

24. Choose the correct statements from the ones given below.

➢  www.blogger.com is a website that allows you to publish your

 work for free on the Internet

➢   www.vimeo.com is a website that helps us share our films      

   on the  internet.

➢ www.vimeo.com is an e-governance website.

➢  www.vimeo.com is a free e-mail service.

➢ www. blogger.com is an e-governance website.

25. Which of the following websites helps you to publish our films 

on the internet for free?

➢ www.vimeo.com 

➢ www.wikimapia.org 

➢ www.youtube.com 

➢ www.gmailcom 

➢ www.yahoo.com  

26. Identify the social media from the following.

➢ google

➢ whatsapp

➢ Wikipedia

➢ Twitter

➢ G-mail

27.  The following are some statements about websites. Choose the 

two true statements from them.
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➢ Websites are hosted inserver computers.

➢  Servers are required in all countries to set up websites 

➢ Multiple websites can be placed on the same server

➢  Only one website can be placed on one server.

➢ Server computers cannot enter multiple IP addresses.

28. The following are some statements about Social Media. Choose 

two true statements from them.

➢ What has been posted on once posted can be retrieved at any 

time

➢ Making vulgar messages and bullying are not crimes as per law

➢  Keep your personal information quite private

➢ Making vulgar messages and bullying are crimes as per law

➢ It is not a good to keep personal information private.

29. Choose from the following the two statements about E-banking 

service.

➢  It is necessary to have Username and Password for E-

banking.

➢ We can transfer money only to our relative’s account.

➢ We can not access the previous transactions

➢  Account holders should own a website

➢ We can access our transaction without going to the bank.

30. The following are some statements about Social media. Choose 

the two true statements from them.

➢ a) The illegal things that are going on Social media can not be 

caught.

➢ b) Diaspora is an open source communication system

➢ c) There is a special wing of police to investigate the Cyber 

crimes.
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➢ d) Do not share pictures and videos in Social Media.

➢ e) IETF  and ICANN are social media
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STANDARD X INFORMATION COMMUNICATION TECHNOLOGY 

CHAPTER 8 – DATABASE -AN INTRODUCTION

THEORY QUESTIONS AND ANSWERS

1) Which is the field type to choose to include a photo in a Libre Office Base data base?

➢ Img [NUMERIC]

➢ Img [SRC]

➢ image [LONGVARBINARY]

➢ Number [NUMERIC]

2. Which is the correct statement related with database management system?

➢ The number of tables which  can be included in database is limited.

➢ The details in database can be removed as needed.

➢ Images cannot be included as data.

➢ Only correct information can be included in database.

3. Which is a database management system in the given list below?

➢ LibreOffice Writer

➢ LibreOffice Base

➢ LibreOffice Impress

➢ LibreOffice Calc

4. Which information can be made as Primary Key when a database of all houses in a 

panchayath is built ?

➢ House number

➢ Name of the owner of house

➢ Perimeter of house

➢ Number of members in the house
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5. You can see a window related with the making of database. Which is the work 

connected here  ?

➢ Table 

➢ Form 

➢ Query 

➢ Report 

6. The policy number, name of owner, age, premium amount are added in a database of  an 

insurance company. Which field can be taken as primary key ?

➢  Policy number

➢ Name of owner

➢ Age 

➢ Amount of premium 

7) What does each row in a table stand for?

➢  Field

➢ Record

➢ Field type

➢ Record type

. 8) What helps a database  to recognise its records?

➢ Field
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➢ Field type

➢ Primary Key

➢ Secondary Key

9) What should be defined to recognise the type of data in a table prepared in LibreOffice 

Base?

➢ Field

➢ Field type

➢ Record 

➢ Record type

10) The admission number was defined as the primary key  in a data base of school students. 

What is the benefit of it ?

➢ It prevents the entry of students with same admission number.

➢ It helps to admit more students in same admission number.

➢ Data can't be included in the field of admission number.

➢ No need of entering data in the field of admission number

11)  Which is used to include details in a table in LibreOffice base?

Query

Form

Field

Report

12)   Select a query language that use to contact with data base.

➢ MySQL

➢ C

➢ C++
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➢ java

13) Which is a false statement about database in the options given below?

➢ Data can be arranged in order

➢ One or more table can be added.

➢ New data can't be included. 

➢ A collection of well arranged data

13) In which name are the columns known as in a table in Libre Office base?

➢ Fields

➢ Field type

➢ Records

➢ Record type

15)  Which is the field type used to include text format in a table in LibreOffice base ?

➢ Img[NUMERIC]

➢ Text[VARCHAR]

➢ Image[LONGVARBINARY]

➢ Number [NUMERIC]

16) You can see a window to define field type in a data base. Which is the field defined as 

primary key?

➢ Book_No

➢ Name_of_Book
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➢ Author

➢ Price

17) Which is the field type used to include number format in a table in LibreOffice base ?

➢ Img [NUMERIC]

➢ Text[VARCHAR]

➢ Image [LONGVARBINARY]

➢ Number [NUMERIC]

18) Which one is not a data base management system (DBMS) in the options given below ?

➢ MySQL

➢ LibreOffice Base

➢ Oracle

➢ LibreOffice Calc

19) Which is the technique used to get data from database based on conditions?

➢ Table

➢ Form

➢ Query

➢ Column

20) Which is the technique use to include data to a database using suitable applications?

➢ Table

➢ Form

➢ Query

➢ Report

21)  Which are the Data Base Management System software in

given below options?
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➢ LibreOffice Writer

➢ MySQL 

➢ Inkscape

➢ LibreOffice Base

➢ Synfig Studio

22) What do you need to do to create table in Create Table in Design View in  Libre 

Office Base?

➢ Field Record

➢ Field Name

➢ Record Name

➢ Field Type

➢ Record Type

23)  Which are two correct statements related with primary key in LibreOffice

database?

➢ Value of primary key will be always unique.

➢ All fields should be defined as primary key.

➢ There should be two primary keys at least  in a table

➢ Max. Number of primary keys in a table is 3.

➢ Each record in a database is  recognised based on primary key

24) Why do we use Query in LibreOffice Base ?

➢ To include data into the table

➢  To get  necessary data from the table

➢ To find out the type of the data in  the table
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➢ To make small tables by including data in the table.

➢ To change data in the table

25) Find out two use of Data Base Management System from the data given below.

➢ Can send email by using DBMS. 

➢ Can analyse data by using DBMS.

➢ Can remove unnecessary data by DBMS.

➢ Can edit video in database by using DBMS.

➢ Can edit audio in database by using DBMS.

26) Find out two steps to create form in LibreOffice base from data given below

➢ Open Use Wizard to Create Form.

➢ Open Use Wizard to Create Report.

➢ Create form by giving necessary details through search condition.

➢ Create form by selecting already prepared table from table or query.

➢ Create form by selecting suitable report  from Create Report.

27)  Find out two steps to create Query in LibreOffice base from data given below.

➢ Open Use Wizard to Create Form.

➢ Open Use Wizard to Create Query.

➢ Create form by giving necessary details through search condition.

➢ Select suitable arrangement from Arrange controls.

➢ Click Finish Button after giving a name in title report.

28) Find out two steps to create Report in LibreOffice Base from data given below.
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➢ Create form by giving necessary details through search condition.

➢ Click Finish Button after giving a name in title report.

➢ Open Use Wizard to Create Report.

➢ Select suitable arrangement from Arrange controls.

➢ Prepare report by selecting suitable layout.

29. Which are the two suitable statements related with a database management system?

➢ Can edit audio.

➢ Can use the date carefully.

➢ Can act as a link between application software and database

➢ Can edit video.

➢ Can increase the data speed of internet

30) A model of  a database is given below. Find out two true statements after

analysing  the image

➢ It shows a record in red box.

➢ It shows a field in red box.

➢ It denotes a record in blue circle.

➢ It denotes a field in blue circle.

➢ It denotes a primary key in blue circle.
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STANDARD X INFORMATION TECHNOLOGY 

UNIT 9 : MOVING IMAGES 

THEORY QUESTIONS AND ANSWERS

1) Who is the creator of the software SynfigStudio?

➢ Ada Byron

➢  Charles Babbage

➢  Richard Stallman

➢  Robert B Quattelbaum

2) Which is an open source software that can be used for making animations?

➢ Adobe flash

➢ Anime studio

➢ Toon Boon

➢ Synfig Studio

3) Which is an open source software that can be used for making animations?

➢ Toon Boon

➢ Tupi:Open 2D Magic

➢ Adobe Flash

➢ Anime Studio 

4) Which among the following is different from others?

➢ Adobe Flash

➢ Toon Boom

➢ Pencil

➢ AnimStudio

5) A part of the window of Synfig Studio is shown below. What is its name ?

➢ Time track

➢ Toolbar
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➢ Parameters

➢ Canvas

6) Which technique can be used to add svg images prepared in Inkscape to Synfig 

Studio?

➢ Export

➢ Open

➢ Import

➢ Render

7) Which tool can be used to run the animation prepared in Synfig Studio?

A. B. C. D.

8) 

Smooth Move Tool .................

Gradient Tool Fill Tool

There are some tools of Synfig Studio and its descriptions in the table. Find out the 

missing  part from those given below.

➢ Circle Tool

➢ Transform Tool

➢ Scale Tool

➢ Rotate Tool

9) Which is a project file of Synfig Studio in the options given below ?

➢ Star.svg

➢ Star.jpg

➢ Star.sifz
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➢ Star.ogg

10) Which is the tool use to give back ground by blending two colours?

➢ Gradient Tool

➢ Transform Tool

➢ Scale Tool

➢ Star Tool

11) Which tool in File menu can be used to export animation projects to 

video in Synfig Studio?

➢ Export

➢ Render

➢ Revert

➢ Preview

12) What do we name the first frame and the last frame when an animation is 

completing through Tweening technique in Synfig Studio?

➢ Motion Tween

➢ Key Frames

➢ Parameters

➢ Interpolation

13) What is the name of each image that prepares in Synfig Studio in the given 

options?  

➢ Objects

➢ Animations

➢ Scenes

➢ Parameters

 14) Which tool can be used to prepare back ground in Synfig Studio Canvas ?

➢ Text Tool

➢ Scale Tool

➢ Rectangle Tool

➢ Smooth Move Tool

15) What is the benefit of including each object in each layer in Synfig Studio ?

➢ Easy to save.
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➢ Can give animation to each object.

➢ Easy to render.

➢ Easy to import.

16) Which tool can be used to change the position, size, shape etc of a star drawn

in Synfig Studio Canvas ?

➢ Circle Tool

➢ Transform Tool

➢ Gradient Tool

➢ Rectangle Tool

17)  Each object in Synfig Studio is arranged in each layer. In which panel are the 

details of objects  displayed ? 

➢ In parameter panel

➢ In tool box

➢ In layers panel

➢ In time track

18) What does this picture in parameters panel in Synfig Studio denote?

➢ Start Animation

➢ Delete Key Frame

➢ Add New Key Frame

➢ Preview.

 19) What is the first step to give animation to the images drawn in Synfig 

Studio?

➢ Put Animate edit mode On 

➢ Put Animate edit mode Off 

➢ Import file

➢ Render file 

20) Software can complete all frames if the first and the last frames are 

decided to give animation in Synfig Studio. What is the name of this 

technique?

➢ Tweening

➢ Frame Per Second
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➢ Render

➢ Preview

21) FPS if an abbreviation related with films.

What does it stand for ?

➢ The number of scenes in a second.

➢ The number of characters in a second.

➢ Total number of frames of in an animation.

➢ The number of frames in a second.

22) Which technique in mathematics helps Tweening  in Synfig Studio?

➢ Fraction

➢ Interpolation

➢ Interaction

➢ Persistence of Vision

23)  In Synfig studio, Ajith is giving animation to a bird that moves from one side 

of the canvas to the other in10 seconds. What is the final key frame in this 

animation, if the FPS is set to 12?

➢ 24 th frame

➢ 48 th frame

➢ 120 th frame

➢ 60 th frame

24) Animation works by using an optical Illusion called........................

➢ Persistence of vision

➢  The range of perspective

➢  Perspective angle

➢ Perspective

25) Which of the following methods can be used to Insert Images [with png/svg 

formats] in Synfig Studio Software.

➢  File→Open

➢  File → Import

➢  Insert →Image

➢ Insert→Bitmap
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SHORT ANSWER TYPE QUESTIONS

1) Select two tools in tool box in Synfig Studio from the options given 

below.

➢ Star Tool

➢ Edit paths by nodes

➢ Draw bezier curves and straight lines

➢ Transform Tool

➢ Draw calligraphic or stroke

2) What activities can be done using Transform tool in tool box in Synfig Studio ?

➢ To change the position of objects

➢ To colour the objects

➢ To change the shape of objects

➢ To export animation

➢ To give tweening to animations

3) Select correct statements about Synfig Studio from the given sentences.

➢ All objects will be displayed in parameters panel.

➢ Layers are displayed in layers panel .

➢ Layers are displayed in parameters panel.

➢ Layers in pane can be rearranged and changed.

➢ New layers can't be created.

4) Some tools in Synfig Studio and its name are displayed in the picture. Fill in

the blanks from below.

➢ Text Tool

➢ Star Tool

➢ Rectangle tool

➢ SmoothMove Tool

➢ Fill Tool

5) Select tools to colour canvas in Synfig Studio from the options given below.

➢ Smooth Move Tool

➢ Gradient Tool

➢ Transform
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➢ Circle tool

➢ Fill Tool

 6)

An image drawn to prepare animation of stars in Synfig Studio is shown above. 

Which are the tools used here ?

➢ Circle Tool

➢ Fill Tool

➢ Text Toolis 

➢ Star Tool

➢ Rectangle Tool

7)  Select two correct statements related with making of animation. 

➢ Synfig Studio is a 2D animation software.

➢ Synfig Studio is a 3D animation software.

➢ Animations are created when the images are moved speedy and continuous 

➢ Animation can't be done by imported still images. 

➢ There is no system to control the speed of movement when it is animated

8)  Select two correct statements about the layer in Synfig Studio. 

Layer system help to animate each object.

All objects will be in one layer.

All layers are lost when an object is removed.

It is needed to remove only a layer if an object is to be removed.

Only a layer will be displayed when it previews.

9) Select two correct statements about Synfig Studio from the given sentences.

➢ The animations prepare in Synfig Studio can export to gif format.

➢ The extension of the project files in Synfig Studio will be .sifz

➢ The animations prepare in Synfig Studio can't export to video formats.

➢ The animations prepare in Synfig Studio can only export to flv format.

➢ The animations prepare in Synfig Studio can only export to mpeg format.
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10)  .birds.sifz and bird.dv are two types of files created using Synfig studio 

software. Find two true statement related to this.

➢  bird.sifz is the file saved a project file.

➢  bird.sifz is the file exported as a video file.

➢ bird.dv is the file saved as the project file.

➢ bird.sifz is the file exported as sound file

➢  bird.dv is the file exported as the video file.
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STANDARD 10

chapter 10 

1) Who is known as the Father of Computer?

A Ada Byron

B Charles Babbage

C Ken Thomson

D Dennis Ritchie

2) Why the  Analytical Engine created by Charles Babbage is known as the First 

Computer?

A It had structural similarities with modern computer. 

B It was similar in shape of

modern computer. 

C The basic concepts related to a modern computer were envisaged for his 

machine too.

D It had the Operating System and 

Programs of Modern Computer.

3) When the GNU Project led by Richard Stallman started to create an Operating System, 

they modeled it on ...

A Linux

B Unix

C BSD

D Debian

4) Identify the very fast file system used to keep the files temporarily in Gnu / Linux `

Operating System. 

A Root  (/)

B Home (/home)

C Swap (swap)

D RAM

5) Which of the following is the most correct statement regarding GNU/Linux?

A It is a Free (open source) Operating System.

B It is designed completely by Linus Torvalds.

C All the main parts of it were designed by Richard Stallman.

D All the parts of it were designed by Dennis Ritchie

6) Identify the Kernel Program of GNU/LINUX Operating System.

A GNU

B Linux

C Unix

D Root (/)

7)Name the part of the Operating System which communicates with computer hardware 



directly or with the help of Drivers.

A Shell

B Command 

C Kernel

D GUI

8) Which of the following is NOT a complete Operating System?

A Unix

B BSD (Berkeley Software Distribution)

C Mac OS X

D GNU HURD

9) Identify the set of persons who participated in the development of Unix Operating 

System.

A Dennis Ritchie and  Ken Thompson

B Ken Thompson and Richard Stallman

C  Richard Stallman and Dennis Ritchie 

D Ken Thompson,  Richard Stallman 

and Dennis Ritchie

10) Most of the operating systems of  today have been built based on or designed like one

Operating System.  Identify that Operating System.

A Window

B Mac OS X

C Unix

D BSD

11) All the hardware parts of a computer need a program which instruct it how to work. 

Identify the name of such programs.

A Driver

B Terminal

C Kernel

D Shell

12) Identify  the process with which the Hard Disk  is partitioned as Blocks and prepare 

File System.

A Commanding

B Installation

C Editing

D Formatting

13)Fill in the blank with suitable word from the following.



The manner in which each operating system formats the hard disk is known as its ---------.

A Shell

B File System

C Command

D Kernel

14) Identify the Operating System which uses the file system NTFS. 

A GNU/Linux

B Microsoft Windows

C Apple Mac OS X

D Unix

15) One of the following Smart Phone Operating system is based on Linux. Identify it.

A Android

B Blackberry 10

C iOS

D Symbian

16) Identify the software which helps to find out the details of the Hard Disk partitions of a 

computer.

A Gnu Hurd

B Disks (gnome-disks)

C KompoZer

D MySQL

17) Identify the Operating System which uses the Kernel XNU.

A GNU/Linux

B Windows  NT

C Apple Mac  OS X

D  BSD

18) Which of the following statements is normally true regarding Proprietary softwares? 

A It is available free of cost.

B The Source Code is available to users.

C Only the Object Code is available to users.

D The Source Code and Object Code are available to users.

19) Which of the following statements is normally true regarding Free softwares?

A Only the Source Code is available to users.

B Only the Object Code is available to users.

C The Source Code and Object Code are   available to users.  

D The Source Code and Object Code are not available to users.

20) Which of the following is NOT an example for Wearable Devices ?

A Smart Watches.

B The Insulin Pumps connected inside the body. 



C Lockets with Camera and Sensors.

D Mobile Phones.


